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& Learning Objective

Guiding you step by step
through the process of
clustering of fiber bundles from
diffusion MRI.

National Alliance for Medical Image Computing



LU

Prerequisites

This tutorial assumes that you have already completed
the tutorial Data Loading and Visualization . Also, the
tutorial, Processing of Diffusion Weighted Imaging

and Diffusion Tensor Imaging data in Slicer3 , is highly
recommended.

Tutorials for Slicer3 are available at the following
location:

® http://www.na-mic.org/Wiki/index.php/Slicer3.2:Training




8 Materials

This tutorial requires the installation of the Slicer3
software and the tutorial dataset. They are available at
the following locations:

 Slicer3 download page
http://www.slicer.org/pages/Downloads/

Note: download the latest file from Nightly Builds

 Tutorial dataset (tutorialData.zip)
http://www.nitrc.org/projects/quantitativedti/

Disclaimer: It is the responsibility of the user of Slicer to comply with both the terms
of the license and with the applicable laws, regulations, and rules.
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Creating initial centers slides 33-39




& - [ntroduction

This module accepts as the input a set of fiber trajectories (3D
curves) and a set of user specified initial centerlines. It groups the
trajectories using an expectation-maximization algorithm and
outputs the membership probabilities along with the updated cluster
centers. It also outputs diffusion parameters along each trajectory
with point correspondence to each cluster centerline to enable tract-
oriented statistical analysis. Details of the algorithm are given in:

M. Maddah, W. Eric L. Grimson, Simon K. Warfield, William M. Wells, “A

unified framework for clustering and quantitative analysis of white matter
fiber tracts,” Medical Image Analysis, vol. 12, no. 2, pp. 191-202, 2008.




£ - Technical Summary@as)

« Trajectories are sampled uniformly.

A 3D curve is defined as the cluster center and is obtained by a
weighted average of all of its corresponding points on the
trajectories.

* A re-indexed version of each trajectory is built to reflect its point
correspondence with each cluster center.

I, = {I‘U} ri(k)

! ith trajectory
M = Mg |

« kth cluster center
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£ = Technical Summary (2/4)

* Trajectories are clustered based on their distance to
each cluster center.

« Euclidean distance and point-correspondence are
calculated efficiently by generating a distance map and a
Voronoi diagram for each cluster center.

A penalty term is added to the Euclidean distance to
account for shape dissimilarity.




£ = Technical Summary (3/4)

A Gamma mixture model is used to describe the clusters
based on the distance between trajectories and cluster
center (d; = |d;1...dix]).

K: Number of clusters is defined by the user
K

p(di[©) =3 dfil(dilgr)

k=1 A Unknown parameters of Gamma distributions

fr(dilgr) = Gammaldi; gr) H U(d;;: 0, do)

J#Fk

Unknown mixing weights

e The maximum likelihood estimation of unknown
parameters are obtained through EM approach.




£ = Technical Summary 4/4)

* |In the expectation step, membership probability of each
trajectory to each cluster is calculated; parameters are
assumed to be known.

e In the maximization step the parameters of the mixture
model are updated.

Once the EM algorithm converges, cluster centers are
updated. The procedure is repeated until convergence.
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& . Module installation(ws)

[ 06 % 3D Slicer Version 3.5 Alpha

File Edit View| Window Help Feedback

AEEE BEEEEIEDEE G

{'& Application Settings F2
& 4

* Welcome & About

3pSlicer Welcome

3D Slicer is a free ocpen socurce software platform for
medical image processing and 30 visualization of image
data. This module centains some basic infermation and
useful links to get you started using Slicer. Please see our =
website httpfwww slicer.org and the decumentation on our

Coronal

MNone

MNone

* Manipulate Slice Views

‘;\)‘—"
EEDDED

“ Manipulate 30 View

=

« Select Extension Manager from View menu.

(&
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& - Module installation(ss)

% 3D Slicer Version 3.5 Alpha

File Edit View Window Help Feedback

Modules: SlicertWelcome search modules @

3 o i : ]
r ) 2osiicer e X/ 3D Slicer Version 3.5 Alpha 1.0

4 Extensions Management Wizard

“ Welcome & About |
1 This wizard lets you search for extensions to add to 3D 3Slicer,
a.. download and install them, and uninstall existing extensicns.
P =< You will need a network connecticn to access remote extension
m“ repositories.

= “3DSlicer \A’

j version 3.4

E Find & Install " Uninstall | Either

Change extensions install path: |3 /Users/mahnaz/Slicer3mahna; L
3D Slicer is a free cpen source 50
medical image processing and 30 vis _
data. This module contains some bag Delete zip files from temp. dir. {optional): F
useful links to get you started using {
website http Mwww slicer org and the

MNone Coronal MNone
* Manipulate Slice Views J None
- " — ' Where to search: |http:fext slicer orgfext/ftrunkf1 037 0-darwir~ 0
EEDIDBEEEE @l |

* Manipulate 3D View J

Select Next
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& - Module installation(ss)

@ iDSlicer

* Welcome & About

version 3.4

m 3DSlicer

* Manipulate Slice Views

E & EEEE

* Manipulate 3D View

3D Sslicer is a free open source so

medical image processing and 30 vig|
data. This module contains some bag
useful links to get you started using {
wehsite http Mwww slicer org and the

File Edit View Window Help Feedback

Modules: SlicerWelcome

[ (5] = @ e

LY 3D Slicer Version 3.5 a_f\lp_ha

B ] (4] [#] @ & (7] [ 7] = @ G2 5§

| 8enon x| 3D Slicer Version 3.5 Alpha 1,_0-

|
‘ Extensicn Management Wizard

-lSeIect extensions, then click uninstall to remeove them from
wour version of 30 Slicer, or click download to retrieve them.

{[Setect [ st [ name ————————" catogory [ oescripton ||}

BRAINSFit Registration
BubbleMaker Segmentation
EMFberClustering Module Tractography
Example Loadable GuiLessModul Examj
Example Loadable Module Examples
HammerRegistration Work in Progress
| LesionS: \pplication Segmentation
|:. LevelSetStepping Segmentation

BRAINSFit is...
This medule ...
An EM approa...
Anexampleo...
Anexampleoc..
HammerRegist...
Set of tools..

This framewo...

< Download & Install S fa
—

o Select EMFiberClusteringModule
 Apply Download & Install.

from the list.
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& -~ Module Installation(ars

File Edit View Window Help Feedback

Modules: SlicerWelcome

m IDSlicer 60 :

D=

X/ 3D Slicer Version 3.5 Alpha 10

4 Extensicn Management Wizard

* Welcome & About

. version 3.4
i

-EMﬁherGusteringModule Tractography An EM approa... 3
3D Slicer is a free ocpen source so)

medical image processing and 30 vig ExampleLoadableGuilessModule | Examples Anexampleo...
data. This module contains some bag -
useful links to get you started using { Examplelozdable Module Examples An exampleo... .
website http S slicer org and thei HammerRegistration Work in Progress  HammerRegist LNone Seronal
WManipulate Slice Views | Lesions pplication Segmentation Set of tools. .
ElECECIEEIEE (Sl LevelSetStepping Segmentation | This framewo... ||y

-l Continue selecting extensions for download or removal,
or click finish to complete the cperation.

BRAINSFit

4 1~ B
g 3DSlicer \AW_IIX

BubbleMaker

N 3D Slicer Version 3.5 Alpha

B [l (4] [#] @ @& [ @ 7] = @) [© 2]

Registration BRAINSFit is...

Segmentation This medule ..

The module status turns)
green upon successful

Installation.
Select Next.

Cancel

)
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.. Module Installation(/s)

k [ Bala] N 3D Slicer Version 3.5 Alpha
File Edit Wiew Windoew Help Feedback
Modules: SlicertWelcome search modules @
4
rb“, Slicer _ %/ 3D Slicer Version 3.5 Alpha 1.0
- 4 Extension Managament Wizard

* Welcome & About
s
| 2 “3DSlicer m
& d version 3.4

3D Slicer is a free cpen source so|
medical image processing and 30 vig
data. This module contains some bag
useful links to get you started using §
website http fwww slicer org and the

Choose to restart 30 Slicer now to incorperate these
extensions changes immediately. Restarting later will make
the changes next time the software starts up.

Restart 3D Slicer now Restart later

* Manipulate Slice Views |

L&

* Manipulate 30 View |

- | EEBE @ |

MNone
Mone

Mo

E 3 i [

Coronal MNone
! MNone
0

 You need to restart slicer to complete the installation
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= Loading data (1/3)

'6 06 % 3D Slicer Version 3.5 Alpha )

it View Window Help Feedback

Load Scene... Ctrl-

SlicerWelcome E lz‘ search modules @

>

Add Volume.

Add Transform...

Save cs | 80O % Add Data

Close Scene Ctr-W | Clear Entries| Select All| Select None| Lakel All| Label None| Centered All| Centered None| FiberBundle All| FiberBundleNone

- (Sooct [Fle [ Typo | lame | Laboivap | Coworou [ rworBunate ||

T T oI TTC
R VErsiof
-

3D Slicer is a free cpen
for medical image processi
image data. This module ot
information and useful links
Slicer. Please see our webs

EN [~
Add Directory| | Add Filefss| | Apply| | Cance!

e Select Add Data from File menu.

e Select AddFile(s).

* Manipulate Slice Views

(=@ LB

* Manipulate 30 View

=]
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& -~ Loading data (2/3)

fallala % 3D Slicer Version 3.5 Alpha

File Edit WView Window Help Feedback

I Modules: SlicenfVelcome E lz‘ i:seas'c-n modules @ @ I I $ 4

13
'ﬁi 3DSlicer
- 800 x| Select File )
Welcome & About =i _ il L
e N < b 52l ) ! Size Modified time
[ 5 wtorialData initCenters.vtp 20 KB Wed Jul 29 15:13:32 2009 |
? (= mfiles | trajectories.vip 2,170 KB Wed Jul 29 15:10:42 2009
=) FVE
%\ ) Guides
) MatlabFns
3 Public
;) Sites
1 Slicer3
3D Slicerisafree :Jg:!ceg'h“:d
for medical image pro _JSI:EEH:E:
image data. This mog 4 it
information and usef jusr —
Slicer. Please see our =in
Shared | ] _ ~ MNone
* Manipulate Slice View i 7 ||| None
1 W b —
LR £
= I = e 0
ElEELE s # || iF
r— - || T e [N
) SR A ) File name: "initCenters vtp" "trajectories vtp" Gpen  |ngs
B

/

 Navigate to where you saved the data.
o Select “trajectories.vtp” and “initCenters.vtp”,

\ Select Open.
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& Loading data (3/3)

LY 3D Slicer Version 3.5 ;_f\lp_ha
File Edit View Window Help Feedback

Modules: SlicerWelcome lz‘ search m
4
*
m iDSlicer

* Welcome & About

| 866 X Add Data

fUsers/imahnazi/projects/DTlAnalysisfFiberClusterin... | Model trajectories

3D Slicerisafree|
for medical image prg
image data. This mog
information and usefl
Slicer. Please see our

* Manipulate Slice Vie\.ﬁ

EEDoEE™ =
P —

=
e Select FiberBundle All.

o Select Apply.

Add Directory | Add File(G

m . Clear Entries| Select All| Select None | Label All| Label None| Centered All| Centered Mgne| FiberBundle All| FibgrBundleNone

el d seect The ———————— — —— ——Tiype | Name | LaveiMap | Centere | FberBunde | A
- fUsers/imahnaziprojects/DTIAnalysisfFiberClusterin... | Model initCenters

~l1

BB AR EE SR E R

(& )
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o

806
File Edit WView Window Help Fet

Modules: SlicerWelt

.rs iDSlicer

* Welcome & About

version 3.4

| [5 3DSlicer .%\f!.%u’

3D Slicer is a free cpen socurce soft
platform for medical image processing
visualization of image data. This mod.
some hasic information and useful link
started using Slicer. Please see our we

* Manipulate Slice Views

EEOLNERER

“ Manipulate 3D View

@ [@]

o I ] | PN ar

Coler

Data

Editor
Fiducials
Measurements
Medels

ROI

¥ SlicerWelcome

Slices
Transforms
VYolumeRendering
Volumes

Wizards
Informatics
Registration
Segmentation
Statistics
Diffusion
Tractography
eT
Filtering
Surface Models
Batch Processing

... EM Clustering (1/5)

% 3D Slicer Version 3.5 Alpha

] [@] [seercnmocuies [ [3] [A] ] [€] [ [F] [#] [2] = ()| ©] (2] (| % % [

xial MNone MNone
e [F=1 . None
FiberBundles 5

Labelmap Seeding

From the Modules, Select Tractography and then

EM Clustering .
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& - EM Clustering (2/5)

| X| 3D Slicer Version 3.5 Alpha
File Edit View Window Help Feedback

|

Modulas: EM Clustering [4] (] E [
rﬁ Slicer '
=
10

Trajectones| tg
Output Clusters| E |

Initial Centers| ini_rs

PR R 4 |k a |k

Fiducials to Pick Initial Centers| Ne

Output Initial Centers None

[E] Axial None @Sagj_ttaj None [&] Corpnal None

e SetthelO parameters: Set the Trajectories to “trajectories.vtp”,

Out Clusters to “Create New Fiber Bundle”, Initial Centers to “initialCenters.vtp”,
Final Centers to “Create New Fiber Bundle” and Output Directory to desired directory.

« Keep the default values for the rest of Parameters.
. Select Apply . )
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& - EM Clustering (3/5)

eoe
File Edit Wiew Window Help Feedback

Modules:

EM Clustering

(ﬁ-" iDSlicer

Perform tract-criented guantitative analysis
Output Directory | (3 DT lAnalysis

File Prefix Name (feature

* Clustering Parameters
lterations |3 3

Compactness of fiber bundles & 4

¥ Advanced Parameters

Default Apply

* Manipulate Slice Views

El @ B EE

* Manipulate 3D View

| EEE

EE (g

% 3D Slicer Version 3.5 Alpha

All Modules

R E = EEE R R

Color

Data

Editor
Fiducials
Measurements
Models

ROI
SlicerWelcome
Slices
Transforms
YolumeRendering
Yolumes

Wizards
Informatics

Mone Sagittal

Mone None

0 [l

Registration

Segmentation
Statistics
Diffusion
Tractography
T

Ciltarime

FiberBundles
Fiducial3eeding

module.

Mone
MNone

0

Coronal

None

[9][<][<]

Mone

MNone

When Clustering completed, go to FiberBundles
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& - EM Clustering (/s)

r@ 06 % 3D Slicer Version 3.5 Alpha
File Edit View Window Help Feedback
Modules: FiberBundles search modules PR
{2"'-3' iDSlicer ’
= 4
- Display
FiberBundle Select: EM Clustering Model =

Line| Tube| Glyph

Tube Display *x
Visibility
Color By FracticnalAnisotropy

Fiber colering [ Tensor property
[ Fiber cluster ID

Scalar Color Map Rainbow :
Clinning MHone Coronal Mone
* Manipulate Slice Views None il None None

= 0 | |r 0 || 0
EEIDEEEEED oE=s oi=E

* Manipulate 30 View

a . :
 Select EM Clustering Model on Display
e« Gotothe Tube tab.

& Select Fiber Cluster ID for Fiber coloring .
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& .. EM Clustering (5/5)

amna \ 3D Slicer Version 3.5 Alpha

File Edit View Window Help Feedback

Modules: FiberBundles E lE‘ search modules g +
@ Slicer '

~ Display

FiberBundle Select: EM Clustering Model1
Line| Tube| Glygh!

Tube Display
Visibility
Color By FracticnalAnisctropy

Fiber coloring @ Tensor property

Fiber cluster I

Scalar Color Map Rainbow

R a

(e Select EM Clustering Modell on Display h
« Go to the Tube tab.
e Set the Visibility on.
Make everything else invisible to see the final
\_ centers, colored by the mean FA. Y,
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& - Quantitative Analysis(/2)

/If you check marked \ e
Perform tract-oriented quantitative analysis [

INn your specified Output Directory B oonee

. 7
you should have these files for each | | -
Cluster X: o=
CIUSterXth OutputCIuZters E:CIu...ModeI E
Ce nte rX . th Perform tract—orientéd quantita.tive analysis.
File Prefix | FA clusterX.csv
File Prefix | MD_clusterX.csv T
File Prefix | ParDiff clusterX.csv
File Prefix | PerDiff clusterX.csv CEEE -

— — - L]

Qﬂ Prefix | _posteriorX.csv / 2




& - Quantitative Analysis(/2)

~

_* -lrepresents missing data.

« On each CSV file, rows correspond to trajectories
and columns correspond to a location along the bundle.

)

4 N

You may use matlab scripts
here to generate plots of
diffusion parameters vs.
normalized arg length for
each cluster.

. /

Farallel Diffusion

05
0

0.5 1

]

.'..\ f'\-"\“f\
(-

-\-h\
e ? TN \"'\,'
\ﬁ!-\/ >
NNy

0 045 1

-25-



o

Slicer

4 N

To work on your DTI data:

 Load your DT volume.

 Load/make your label image (ROI).

 Follow the next slides to do tractography and to
create initial centers. Here, we use DTIl.nhdr and
FA-label.nhdr as our DTI and ROI volumes
respectively.

< /
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& - Loading DTI volume

I3 3D Slicer Version 3.5 Alpha
GEIE8 Edit Wiew ‘Window Help Feedback

Load Scene...  CtrhO |

Import Scene.. iicerWeIcome ——J. E E‘ search modules @

Add Data... Ctrl-A ; =

Add Volume. . \\\

Add Transform.... ™

Save Ctrlks | =

Close Scene CHrl-wy l

Exit
(B2 3psiicer

. . version 3.4 W e | C O m e

3D Slicer IS @ free open source software platform for

medical image processing and 30 visualization of B

image data. This module contains some basic \\\

information and useful links to get you started using

Slicer. Please see our website hitpfwwi slicer.org and =

3D Slicer 15 distributed under a BSD-style license; for Fi, b [ =

details about the contribution and software license & ; foaal = :: Hone _J: :bag'ttal_J.-: .. |
* Manipulate Slice Views IE”IE_' Hane “r |_|i;||;| | (@] None — | ] None |

&-r' || 22 ‘w_;) A || o

EREONEEEE EEC B || — 1 —

 Select Add Volume from File menu.
 Navigate to where the data Is saved.
 Select “DTl.nhdr” then select Apply.
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=« Loading label map

I2 3D Slicer Version 3.5 Alpha

ZCN Edit Wiew Window Help Feedback

Load Scene... Ctrl-O

Add Data... Ctrl-A
Add Volume. .

Add Transform....

Save Ctrl-S
Close Scene Ctrl-y

,~ 3DSlicer

version 3.4

3D Slicer |5 & free open source software platform for
medical image processing and 3D visualization of
image data. This module contains some basic

information and useful links to get you started using

3D Slicer |5 distributed under a BSD-style license; for
detalls about the contribution and software license

* Manipulate Slice Views

Welcome

Slicer. Please see ourwebsite hitp i slicer org and

(=

Import Scene. _icerWeIcome ——Ai lz‘ Isearch maodules @ ‘

EEIDEEEE B

~

\

Repeat the procedure
load “FA-label.nhdr”.

to

)
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3D5licer

Tractography (1/4)

[- Select Labelmap Seeding module}
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@ 3DSlicer
>

Tractography (2/4)

L- Set the IO parameters.}
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@ 3DSlicer

Tractography (3/4)

[

Based on your application, set the other
tractography parameters.
Select Apply .

|
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L V)

3DSlicer

Tractography (/4

\

The output of tractography appears on the viewer.
Fibers are colored based on their Fractional
Anisotropy values.

~
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& - Creating initial centers (1s6)

/If you do not have Iinitial centers (from an Atlas),
there are two ways to create and pass them to
the clustering module:

1. Extract trajectories by doing tractography on diffusion tensor
data from a set of carefully selected seed points (Steps are
explained in the next slides) .

2. Pass a fiducial list to the clustering module (Fiducials to Pick
Initial Centers ). In this case the module internally picks the
closest trajectories to every fiducial in the list and will use
them as the initial centers. Set the Output Initial Centers to

“Create New Fiber Bundle” to examine the selected initial
\centers after the run is complete. /




DSlicer

Creating Initial centers (2/6)

Set Fiducial List to Create New FiducialList.

Select one of the slice viewers by clicking inside

the viewer.
Add fiducials at desired places by entering p.

~

)
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= Creating Initial centers (3/6)

[Select FiducialSeeding module}

-35-



Creating Initial centers (/s)

Set Output FiberBundleNode to Create New N

FiberBundle.
As soon as you set your Fiducial List as an input in

Select FiducialList or Model, tractography is being
done with the default parameters. Y
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Creating Initial centers (s/s6)

Set the Fiducial Seeding Region Size to 0.0to
get only one fiber per seed.

On the viewer you may move around every seed to

get a trajectory that represents the shape of your
desired cluster.

~

%
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Creating Initial centers (s/6)

[To cluster your trajectories go to EM Clustering module}
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@ 3DSlicer
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